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VEE Pro”7 7 2 V{2 X 9 Z % ! Agilent VEE (Visual Engineering Environment)
3. BAFEREH ORI R MG 2 AR T 2 XU 7 AR EY 2 T AVSRERIE T, &
E1L, Agilent VEEDO AFIH A RT9, Agilent VEED A > A h—/L D05 &
FEIZOWTHBHA LET, AEIZIL, USBA 4 7 = —ARETOHERR L D
BHIELBIEOIER, £ iiEZ R L2200 F 2— MY TANEGENTWET,

Agilent 10 Libraries D1 > X k—JL

Agilent IO Libraries Suite ¥ 7 b7 = 7%, Agilent VEE% [if A L 72BRIZfHE L T
WET, ZoY 7 huoTI2kY, JERE Y 7, USB, GPIB, F72/ZLAN
AUHE T 2 —AFHTHEMTZAD L IR ET,

Agilent VEEZ i H L CHIERR & W15 217 5 LEN & 556121, Agilent VEEZ
A A h—/L 3 B il Agilent 10 Libraries Suite 16.1% 1 > A h—/ L3 5 M3L3
b0 ET, L LAESRZHEH L2 WIGATL, Agilent 10 Libraries Suite D1 >
A M=V EITDIRNE D BIRTEX E,

PAFDA A M=V FIEHIZHE - T IZE0,

1 Agilent IO Libraries Suite CD% CD-ROM R 7 A 7 I\ZHfiA L £ 7,

2 InstallShield® WizardDIERIZHESTA VA F—L T VET, Nextz 27 U v
JLTCT ANV NREEZITAN, A VA M—NVEZETLET,
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3 Agilent Connection Expert Welcome Screen” « > RUMNFRINET, ZOD
T r—a T, PCITHEERE S LTV 2 IERR DORE
RFUZB LT, ROAT v IR ET,

Scan, verify and
manage instrument /0

Tasks for This Instrument

B mefress s nstumest
[ changeprenenies
|&m send communss tos
B atrement

ig Change the label

T sadaprogunmes stas
&) tinere

¥ vene

|®3 2acaninsumen:

‘General Tasks
__"‘_l Instant access to common
T et operations and user help
o

View and change sattings 2
for the selected tem

PR O INSTR:

Agient Technaiogies 33220AREVAIHY 15,1
Agiens Tesnasiogies -
332204

REVASHYIE

105110422

More Information

) Hoadolge criversy

jj rhere can 1find
programming sanplest

160137240

Shiows this window at startup

Close Welcome Screen

Quick access to 10 tools:
@ 'ﬁw sl 28D s52rm
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Agilent VEE Pro D1 VX k—JL

1 Agilent VEE-1 >~ X ;}—/LCD%fEA L. Install Agilent VEEPro9.3% 7 V) v 7 L
%9, InstallShield® Wizard DF&RIZHE> TA > A b=V EITWVET,

Agilent VEE 9.3 Installation CD

Install Agilent VEE Pro 9.3

Install Agilent VEE Runtime 9.3
Install Microsoft .NET Framework 3.5 SP1

2 InstallShield® Wizard 73, Agilent IO Libraries Suite 16.1231 > A h—/L &}
TWEINT =7 LET, A VA F—LINTWRWGEE, LFTOA vy E—
VR I ARKRTIINET,

‘Agilent VEE Pro - InstallShield Wizard

Agilent VEE requires Agilent IO Libraries Suite 16,1 or greater for communicating with instruments.

E Agilent IO Libraries Suite 16.1 or greater is not found.
Please install Agilent IO Libraries Suite 18. 1 ar greater after finishing this setup.

Agilent IO Libraries Suite 16.11%, Agilent VEE % { Jil L CHIES: & @5 217
A DRHRESIETT, LERN->T, Z0OA & h—/L# T 1% IZ Agilent 10
Libraries Suite 16.124 FZ A > A F—/L LT 7230y,

3 0Kz72 VU v 2775 2% &, InstallShield® Wizard”Microsoft NET Framework 3.5
SP1 A VA R—=LENTWINE I DERLET,

4 Microsoft NET Framework 3.5 SP1231 > A h—/L I TV WGHA, A A
F—=F 2L IITKRDDLZEDQuestionZ A T T « Ry 7 ANRFRINET,
Yes% 27 U v 7 L TMicrosoft .NET Framework 3.5 SP1% 1 > A h—/L L &
T, A VA=W D L. Agilent VEED A > A b — L7 H BRI HkRE S
nNEF, Nox7 U v 27 325E, Agilent VEED A VA h— R IESLET,
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Microsoft .NET Framework 3.5 SP1 2314 > A h— /L X3 TW5Y

5 6
InstallShield® Wizard |33 K L 7= Agilent VEED A > A b — /)L RIED 2T v 7
IR E T,
Question

) Microsoft .NET Framework 3.5 SP1 must be installed before installing Agilent VEE.
L/ Do you want to install Microsoft \NET Framework 3.5 SP1 now?

b ROXA Tl - Ry ANRFREINTZH, Nextz 7 Vv 7 LET,

Agilent VEE Pro 9.3 Setup

[X]

‘Welcome to the InstallShield Wizard for Agilent
VEE Pro

The InztallShigld® \wWizard will install Agilent WEE Pro on
wour computer. To continue, click Mext.

6 License Agreement¥ 4 7127 « Ry 7 ANKRINTZH T A &L AZKIZH
EL. Nextx 27 U v LET,
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Agilent VEE Pro 9.3 Setup

License Agreement '
Pleaze read the following license agreement carefully. }J
L

The license agreements contained here are for 2 different uses of this =
product. Please review and click to accept the appropriate license :
agreement for the product you are installing, either a purchased product,
or a 30-day Evaluation usage.

Evaluation License

LEGAL MOTICE: PLEASE READ THESE LICENSE TERMS BEFORE
INSTALLING OR OTHERWISE USING THE LICENSED MATERIALS L
ALL USE OF THESE LICENSED MATERIALS 1S SUBIECT TO THE (e

(%1 accept the terms of the license agreement

() | do not accept the terms of the license agresment

< Back " Mext > ][ Cancel ]

7 Customer Information¥ A 7 127 « iRy 7 ANFRENT- 5, 4. 24,
WX —%2 AL, Nextx 27 U vz LET, 8% —13, Agilent VEE Pro
Product Key CertificatelZ el ST\ E 9,

Agilent VEE Fro 9.3 Setup

Customer Information
Please enter your information.

Uzer Mame:

Company Mame:

Product Key [Enter EVAL far a 30-day evaluation install):

Install this application for:
(%) Anyone who uses this compter (al users)

© Only for me [AGILENT TECHNOLOGIES)

[ < Back I[ Mext » ][ Cancel

8 ROXATHT Ry ANFKRINTZD, Nextz 7 U v 7 LTT 7 4L bk
EEFEHALET,
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Algilent.qEE Pro 9.3 Setup

Choose Destination Location

Select folder where zetup will install files.

Setup will install Agilent WEE Pro in the following falder.

Tainstall to this falder, click Mext. Toinstall to a different folder, click Browse and select
another folder.

Drestination Folder

£ Program Files\AgienttEE Pro 8.3 [ Browse.. |

< Back " Mext > ][ Canicel ]

9 Setup TypeZ A 717 « Ry 7 ANKRINT- 5, Typical SetupZ iR L, Next
7YV LTA VA M= EKRTLET,

Agilent VEE Pro 9.3 Setup

Setup Type
Select the setup type ta install

Click the type of setup you prefer, then click Nexst.

(%) Typical Frogram will be installed with the most commaon options. Recommended for
mosk users.

() Compact  Pragram will be installed with minimum required options.

() Custom ‘You may select the options you want to install. Recommended for advanced
ugers.

< Back ][ Mewt > ][ Cancel
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FRTOF A4 S5 L > Agilent VEE Pro 9.3 > VEE Pro 9.3 % 3#4R L C. Agilent VEE Pro
B LET,

AZa—-
N | EJl Untitled - Agilent VEE Pro
A = Ele Edit Yew Debug Flow Device System If0 Dsta Display Took Datsbase  Excel Window Help
W JIN— —F DEHS b a@9 i 0 a3 S NBMA: Aaw EO8E Bk sd Tau @28
Program Explorer hanatadl ¢ Main E
) Untiled o
s EER g
s
Program H
]
Explorer ki
W
o
s
=7
RAR—R g
§
2
]
- — 2
rk5C%1 Agilent VEE Pro Agilent Technologies &
o, 1
"b a4 2 I "7 Introduction T|p of the Day
What's New Yau tan view a VEE Ohject's menu by clicking
. Wik DEfba on the upper-left hand comer afthe object or
Propel'tles _ ERTENSS  byrightclicking anywhere over the object
MATLAB Examples
o,
ry ‘f ~ |~ rj Example Programs
i~ Show this screen at startup
Output
HAVEY |
Title string of the object
|—\E Output |
X7_'_9 R Ready ExecMode: VEES | PROF |M00 | 0 | |
e p— |
IN—

Agilent VEE Pro® (X5 Z%] v 4> Rund, TF, MATLABY > 7407
e TR TRIT I REATEET, MERLEDL, [KO5Z2%] Uvr v RUIRHT
ThEVERA,

PN TaTTAEL, Ama— R bA—T o TEET, BT
7'v 7T LA —7" 3 51213, File > Open Example ... & 7= /X Help > Open Example...
g N D=
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IDOFa— U TATIE, USBA v & 7 x— ARH CHIERICES LET, (¥
w1 AR Agilent 10 Libraries Suite 16.128A > A h—/L &N TW5D Z & %
BLTLEEN,

USBHIESRD 2 WS, GPIBHIESRDOF 2 — U TIULEAT v 73 HIFER T
/C“‘a—o

1 PCOUSBA— MEH CHIEHRICER LET, HIEROEREZA I LET, #
LWA—=Ru =27 ORET 4P =R Z 470l Ry 7 ANERENDGE
BHYFET, IANE7 Y w7 URIT TP —REKTLET,

2 Agilent VEE Pro% L@ L £9 (&E& L TW2RWEE), Y —/L 3—DlInstrument
Manager: 7 > Bl 227V v 7 LET,

3 Instrument Manager” —/V + 7 ¢ > RUMNFR/RILE T, Find Instrumentsh & >

@%7 Uy 732%&, PCICERESNI-T X TOMELSRD HEHRIZHE S
=7

ByFind . 'S [ 7]
HID
k=

EE:? I'\.I'II DHD: I:'I:INI l:l:'TI
o |Find Instruments..

4 Identify Instrument’ ™ > 7’7 v 7« XA T a7 - Ry 7 ANRKRINTZH, Yes
27U w7 LET, ZHICEY, USBA ¥ 7 = — 2 EORIERN HEIIZHK
MSET, ZOFITIE, Agilent 34410AT 4 ¥ Z )b+ Y VT A —FZ —PIEE
LET,

Identify Instrument
Send "*IDMN?" to newlnstrument  { @USB0:2391:1543:MY45001050:0:INSTR)'?

The response to "*IDN?" provides an
@ accurate identification of this instrurment.

Mote: Older, non 488.2 campliant instruments do not

understand this command. Ifthis command causes an
errar in the instrument, cycle the power on the

instrument to reset it.
| o
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10

B Instrument List’ S/ CnewlnstrumentZz 457 U v 2 L%, 7RIZ. Create Direct
170 Object 23R L, 3R L= newinstrument®Direct /047 V=7 N & U —7 A
NREBELET, ZOFT7 Vs MIEY, WERE DV ROEZE
NHFEIC 72D 7,

- @ USEO

k] newlnstument|ag3441 Da@USBDevigs

Create Direct Ij0 Object

|:|:_ E‘:’!

add Instruments ...
Configure Drivers

Load Sample

Delete Inskrument Dl

& % B,

Instrument Properties ...

6 Direct/OA 7V FOFED T LoHF Iy ar - RN"—aXLTLr) v LT,
Direct /OA 7Y =7 M RZ ¥ 7 v araBMLET,

7 »+I1DN?” (BIHGZEET) &5 35515 1/0 Transaction¥ 4 727 « R
JAZTFROE AT LET, ADHIC, EHAEEZRSCPI2~ v Ro—&
MERRENDLGERHV ET, ZOHE, a~v 2 REEKEAN LR TH, &
o< RERIRTEET, 0KZ2 ) v LCRICERET,

*IDN? 1%, I8 23123 B 551 &2 [ & o+ % Standard Commands for
Programmable Instruments (SCPl) =~ RD1->TT,

—|newlnstrument (ag34410a @UsbDevice2) |
= Double-Click to Add Transaction = v

/0 Transaction

4

| wrRITE ~| | TEXT =] [P*DN?

[ DEFAULTFORMAT | EOLONM

ok | mnop | cancel
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8 “IDN? 7 U ZMEMRIIEFE LS, TOIREE) — Ry 7T H50ERD
Y £9, newlnstrumentt 7 V=2 FDOTFAK Ry T AEBXT VI U v
LT, LT FrvarvzBMUES, SR xEW I ARTOH T
F~®DSTRING FORMAT7 5+ 2 h ZREAD T 5 7= D T 37 2 a U &@EIR L
FT, 0KEx 27 Vv 7325 &, MNP HBIMIERINET,

WRITE TEXT "*IDMN?" EOL

= Double-Click to Add Transaction =
YO Transaction

| READ ~| | TEXT x| K

WEAGTTENA I -]  DEFAULT NUM CHARS
SCALAR »

ok | mnop | cancel

9 Display > AlphaNumeric # E&4R L, AlphaNumeric4t 7Y =7 F & U —27 A—
Z DDirect /047 Y =27 FOFICEE L ET,

Display | Tools Database E;
|[:J Alphakurmetric [\>

E
=5 Logging Alphahlurmeric

Indicator k

10 Direct [/O4 7 ¥ = 7 |k % AlphaNumeric4 7 ¥ =7 MIEHLET, v~ 7 AD
71— V% Direct JOD W 81 DREICE LV IEFBOT A 2V BHEAET,
DA R %27 Vw7 L, AlphaNumerict 7 ¥ =7 DA FE T
MEBIEET EVvUVRRE U E L) —EZ Y v LT BlRAEXET LET,
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WRITE TEXT "*IDN?" EOL
READ TEXT x 8TR
= Double-Click to Add Transaction =

MY — L N—ORmRZ | = | VU7 LT, Tl I AaEETLET,

12 TONIZRT L 512, AlphaNumericA 7 ¥ =7 b3, HESRIZE > THI X
NIRRT TR LET,

WRITE TEXT "*IDMN?" EOL
READ TEXT x STR =

= Double-Click to Add Transaction =

Agilent Technologies, 344104 My45001050,2.03-2.03-0.09-43-6

13 VEE = — RZ{R1FT 5 7=, File > Save AsZi#IR LT, 7 7 A /LT Tutorial
Lvee: \ ) ZEiZfHT £,

12
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REESRF1—FITIL

ZOF a— Y TITIE, RBESR»SEBEER L CFRRLET, HIEZRT

;T:g‘(\“g—o

1 Agilent VEE Pro® VU — 7 A_R—RAIZBAET 1 7T ABEIET 5854, File >
New 7% iER L £ 9, &iZDevice > Virtual Source > Function Generator % 3R L C.
T ar e Ve —F F T NET— 7 A= IEE LE T,

Device | Swskem  If0  Data  Display  Tools  Database  Excel  Wind
= Formula SARUR- Y B
MATLAE Script
JFx | Function & Object Browser Crrl+H !
[“4 UserObject
[##{ ThreadObject
| UserFunction
Call
Lt Import Library
Ly Delete Library
Seguencer
| Wirtual Source '||i Function Generakor
Regression |:| Pulse Generakar
Fr_lr Counter I:‘ Moise Generatar

2 TTUFNVET, Zrvrvay - Poprb—2E, Ak#%200 Hz, RIE1OMK
ata B EER L £,

—| Function Generator =]
Function | Cosine |
Frequency | 200
Amplitude [ 1
Deoffset | 0 | Func|
Phase [Deg=][ 0

Time Span 20m

Mum Points 2565
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3 Display>XYTraceZ R L, XY Traced 7V = b7 77 gy« VxR
I/‘_'& @E&:EEE 1/351;_‘0

Display | Tools Database E:

|

Alphaturmeric
Logging AlphaMurmeric

Indicator 3

{w¢  mY Trace
e Strip Chart

Complex Plane

4 7y vay s VoRxb—2OHNETEXY Trace® A 18 L &
TR TRADH—INE Ty ay - VR —F O OREICE <
L. EFEOTAarPNBnEd, E~UA KX %7 Y v L, XY Trace
FTV 2l NOANGTETCHRESEET, EvTVR-RF U E2H 9 —ES
Uy 2 LT, a2 T LET,

= XY Trace =

= = Y name
Function Generator =

Function Cosine hd

Frequency 200

Amplitude [ 1

DcOffset 0 Func i——=&1

Phase [Deg = 0 Trace1

Time Span 20m

Mum Points 2565 0 < v

= 0 0.2 0.4 0.6 0.8 1

X name

5 V—AA_—@RmKLZ M| 2209358 XY Tracedt 72 =7 MC
ab A UEERERENET,
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6 Display > Spectrum (Freq) > Magnitude Spectrum % &R L . Magnitude Spectrum
FTx) N T~ AX—ADXY TraceA 7oz bO FICEELET,

Device  System  LI/0  Data | Display | Tools Database Excel Window Help

RCRGER X b0 |[T) Alphalumeric =kﬁ9’aiﬁﬁ CE A EHEE S S

I = Looano Aphetumere

Indicator

{r HY Trace
fiy strip Chart

Complex Plane

faly Hws Y Plot
{4 Polar Plat
iy waveform (Time) - AT ITEES =
| Spectrum (Fredq) L4 | Lo Magnitude Spectrum L\\gj
—_ Function Genera Picture Phase Spectrum
Function Cosine Label Magnitude vs Phase (Polar)

Magnitude vs Phase (Smith)

Frequency | 20 Beep
Amplitude [ 1| Mote Pad
Deofzet | 0 | Fune
Fhase Deg ~|[ 0 Tracel 0:2

Time Span 20m 100m

MNum Points 256

1+
1

u] 0.z 0.4 0.6 0.8

Hname

1 77 7vay - VXL —%DOHJ15 5 Magnitude Spectrum4 7 ¥ =7 b
DA, AT v TATHELIZESTRA - RE D7 Vv I BIXORNT v
LRICFET2ERDOTA VA LET,

8 Runkyy B | 22050 LURIEASY b5 AR ERALET, BRI
200 Hz=2 %A > Th D70 RIEARY b T A& L THENEE200 HzIZHER 23
REINET,
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= XY Irace =

= 0.3

—| Function Generator = Y name i,
Function | Cosine =] ot
Frequency | 200 02
Amplitude | 1 0
-0.2
DcOffset lf Func —1 ve
Phase Deg = 0 Trace1 _U:E
Time Span 20m e

Num Points 256 . . J K

) 0 4m  8m  12m  16m 20m

X name
= Magnitude Spectrum =]
140 =
Mag 420
100
a0
60
1

Tracet *°

4 [

1} 2000 4000 60007000

Freq

9 T 7 vary s VR — X OREHRIEZ TTRBICET LE T,

—| Function Generator =

Function

Sine
Frequency X
q : Cosine

Amplitude Square

DcOffset Tri Funec |
+Ramp

Phase -Ramp

Time Span | 22001

Mum Points 2565
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10 Runhz > W 227007 L EOEEELET, Aglent VEEZ M5
L BRBEFICERD 7 T 7R LTS ESE R PITAET,

= XY Trace =
1
- 0.8
= Function Generator = | rreme
Function Square ¥ 0.4
Frequency 200 0.2
Amplitude 1 o
-0.2
DcOffset 0 Func [i—1 o
Phase Deg = 0 Tracet e
Time Span 20m 0.8
Mum Points 25 -1
256 4 [v]
= 0 4m  8m  12m  16m 20m
X name
= Magnitude Spectrum =
180
Mag 180
140
120
100
a0
— 60
Trace1 40

| [

1} 2000 4000 60007000

Freq

11 VEE 22— R %159 % 7= File > Save As % 1&IR L T 7 7 A /LIZTutorial 2.vee
LW LT £,
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vlools

2f&¥H DvTools (General vTools & DAQ vTools) % F|H TX ¥9, General vTools
W%, BEEEIER SN T 7 ATV b (X, AZa—b e X—Ah, TT
T4y VRIFHERE. VT 7 AT V=7 b - LAR— MEREE M) E S H B EIRIBERE
E&Te) WEENTUWET, General vToolsit, AveragingX°Marker Lookup’ &
DFATVxr hRaryR—3 b ¥R — KL TWET, DAQ vToolsa T 5
L. K EHICHKA TE, DAQE Y = — /L ? Agilent Measurement Manager >
AR SN T 7 A VBRI FR— b IET, DAQ vToolsiL, Agilent U2300F L
VU25003 ) —AUSBEY 27 « 77— INET A ZAMZOMEN TE £,

FLOWHUTIL - TATS LA

Agilent 335003 U — X, 34411A DMM, DSO/MSOA4 L 1 A =a—7FHOH L\
VN T T ARBHYET, INLDH LWL - e s T AT, B
DOAgilentFHlIZE LVEEA O Y I N7 a7 T 0 JOTFERTT, HiLniv
T T T DT DML, VEE 9.8~ 7 7 A A BRI L T E &0,

Agilent(F. HE#EID 1 —H R ITIZ. Agilent VEE Student/X\—2 3 > &
Agilent Education/A—2 3 U ERBELTWET,
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F-- :. =
"‘\-_'."%"-F-E'
N
E5810A LAN/GPIB 82357B USB/GPIB 10833X GPIB
F—rkozAa A3 TT—R =TI

823508 PCI GPIB 82351A PCle GPIB
A1 037x1—X A3 TT—R

Agilent TlE, PC & HIESS 2Bt 9 5 72 8 D & VERE TIEHEME 0 s RLYL A2 30 2
TWET, T2l LAN/GPIBY — h ¥ =1 | GPIBZ — 7 /LPCI GPIB, PCle
GPIB, USB/GPIBA > ¥ 7 = —ANEENTNET, Agilent2 327 7 1 &7 ¢
ShDFEZ OV T, www.agilent.co.jp/find/gpib Z ZE < 72 &0,
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Agilent DY HR— k., Y—ER, PRI VR

Agilent VEE Pro®ffi FHH, Agilent® UV —/L KU A KD U YV —RIZTZ7E®ALT,
AR —=K"NT T« TIVARAE LA, "o —=u T« VTR Ty FF—h«P—t
ZE2FIMT D2 ENTEET, Agilent VEERIF O AD—EE LT, T/ =7
b R— P NERE T SR AW T T, BEEOLEITH Y TEAL

AgilentCl, ZOfMDO ALY AT 47« F—ERABITo TWET, BIfE, LK,
F—nu X B, TUTD30% 82 A ETAgilent VEEY V = —3 3 U OBHIFEIC
KT DY R— MR L TWET,

Agilent VEEE 1= —¥ « 7 /L—7 (http://www.agilent.co.jp/find/veeforum) (Z
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